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Introduction 

Paragon Drive Copy™ 11 Professional includes all latest innovations in migration of Windows OS and data to different 

environments. With its help you can: 

 Move your Windows (any version since XP) from a regular hard disk to a fast SSD (Solid State Drive) even of a 

smaller capacity, thanks to advanced data exclusion capabilities. Speedy, yet completely indifferent to 

mechanical impact SSD enables to get the most out of your system with minimal risk. 

 Migrate your system based on Windows Vista and later editions from an MBR disk to the latest 2.2TB+ HDD on a 

computer controlled by the old BIOS, not the new UEFI (Unified Extensible Firmware Interface), thus taking 

advantage of modern ultra high capacity hard drives on systems that don't support it. 

 Pack up your Windows (any version since XP) to a special container for later deployment on a different 

hardware configuration. It’s the best option when upgrading HDD on laptops, which most likely can 

accommodate one hard disk only. 

 Augment 32-bit Windows XP by adding support for GPT (GUID Partition Table) disks, thus having the option to 

transfer and store data on new internally connected ultra high capacity hard drives. 

 Migrate your Windows (any version since XP) to a different hardware platform. When upgrading to newer or 

just replacing failed hardware use our unique P2P technology to guarantee startup of your system on a 

dissimilar hardware configuration. 

 Transfer your Windows (any version since XP) to a virtual environment of Microsoft Virtual PC, VMware 

Workstation/Fusion, or Oracle VirtualBox (P2V). 

Most functionality of the product is offered through handy intuitive wizards, that’s why not only IT pros, but also 

inexperienced users can find it easy and efficient. 

In this manual you will find the answers to many of the technical questions, which might arise while using the program. 

 

Our company is constantly releasing new versions and updates to its software, that's why 

images shown in this manual may be different from what you see on your screen. 

What’s New in Drive Copy 11 

 Migrate OS to SSD to move any Windows OS since XP from a regular hard disk to a fast SSD (Solid State Drive) 

even of a smaller capacity, thanks to advanced data exclusion capabilities. 

 GPT Loader, a special system driver to allow use of all space of modern ultra high capacity drives (larger than 

2.2TB) on systems that don't support it. 

 The updated Copy HDD Wizard that now enable to successfully accommodate and startup any Windows OS 

since Vista on a storage larger than 2.2TB in size, that is connected to a computer controlled by the old BIOS, not 

the new UEFI. 

 The updated P2V Copy Wizard to migrate a live Win2K+ physical system to a virtual environment of one of the 

supported virtualization software vendors. In the latest version of the product the wizards enable to: 

- Create and properly configure virtual machines according to your preferences. Depending on the selected 

virtualization vendor you’ve got the option to specify a version of the future virtual machine, its name, 

location, RAM to allocate, a disk controller, the guest OS, etc. So when the migration is over, you’ll get not 

only a virtual disk that contains an operating system and/or data, but a ready-to-use virtual machine. 
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- Convert any combination of hard disks and partitions to migrate your entire computer or certain partitions 

in one operation. 

- Employ MS VSS (Volume Shadow Copy Service) to synchronously migrate from several hard disks, thus 

ensuring data consistency during online migration of a system, which seats on several partitions or hard 

disks. This is achieved by taking a point-in-time snapshot of the whole disk subsystem. 

- When migrating from several hard disks, all their signatures will be kept intact, so you’ll get the same drive 

letters in a virtual environment. 

 The updated P2V Adjust OS Wizard allows creation of virtual machines as well, so besides its primary function, 

you can now build virtual machines out of supported virtual disks or Windows Vista/7 backup images. 

 The updated P2P Adjust OS Wizard to successfully start up a Win2K+ physical system on a different hardware 

platform (P2P) by allowing injection of all required drivers and the other actions crucial for this type of 

migration. Including the third generation of Paragon’s Adaptive Restore™ technology, it now can: 

- Analyze all installed drivers inside a target system to report on devices without drivers. 

- Search for and install lacking drivers from the built-in Windows repository. 

- Notify the user about boot critical devices without drivers (HDD/RAID controllers, etc.), automatically 

prompting to provide a path to a driver repository. 

- Name all devices according to their model description, not some alphanumeric code, which requires 

additional deciphering. 

- Determine and install drivers not only for boot critical devices, but for physically connected NICs as well. 

 Automatic partition alignment during partitioning/copy operations to optimize performance of your hard disk. 

 Check FS Integrity and Data Loss Policies to let you specify the acceptable balance between the operation 

performance and the risk of data loss. 

 Conversion of basic MBR disks to basic GPT to enjoy all benefits of the newest partitioning scheme with 

minimal effort. 

 WinPE 3.0 based bootable environment to enjoy support of a wider range of hardware configurations with the 

option to add drivers for specific hardware on-the-fly. 

 The updated Boot Corrector for WinPE that now equals the functionality of the Linux/DOS counterpart. 

 Support for Retained GPT (also known as Hybrid GPT), a special combined GPT+MBR partitioning scheme, 

where the first three partitions except for EFI (GPT service partition) are synced between GPT and MBR. This 

synced partition map provides an avenue, for instance for booting 32-bit Windows Vista/7 on a 2.2TB+ disk on 

computers controlled by the old BIOS. It’s also used for dual booting Mac OS X and Windows on a GPT disk. 

 Support for exFAT (Extended File Allocation Table) file system (backup, restore) developed by Microsoft 

Corporation particularly for flash storages. It supports drives up to 16 exbibytes, files much larger than 4GB, 

larger cluster sizes, etc. 

 Better support for HFS+ that now includes not only resize capabilities, but create, format, and read only access 

through our program as well. 

 Better support for 64-bit platforms to reboot your computer to one of the three special modes (Windows 

native, Linux, or DOS) to automatically complete operations, which cannot be accomplished under 64-bit 

Windows. 

 AFD (Advanced Format Drive) ready. 
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 Support of 2TB+ and non-512B sector size drives. 

 USB 3.0 ready. 

Product Components 

In order to cope with different tasks, the product contains several components: 

 Windows based set of utilities is the crucial part of the product. With the help of an easy to use launcher you 

may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and 

cloning, etc. 

 Linux/DOS based recovery environment is a multi-platform bootable media that enables to run utilities under 

Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both 

platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB 

devices. It enables to burn CD/DVD disks. However there can be some difficulties with detecting new hardware. 

DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS recovery environment 

requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XP 

like environment. 

 WinPE based recovery environment. Especially for keen followers of Windows, our product also offers a WinPE 

3.0 based bootable media. Unlike the Linux/DOS recovery environment it can boast an excellent hardware 

support and the same interface as the Windows version can. However its system requirements are much 

tougher. 

Features Overview 

This chapter dwells upon key benefits and technical highlights of the product. 

Features  

Let us list some of the features: 

User Friendly Fault Minimizing Interface 

 Graphical representation of the data to gain a better understanding. 

 A handy Launcher to easily find and run the required tasks. 

 Comprehensive wizards to simplify even the most complex operations. 

 A context sensitive hint system for all functions of the program.  

 Previewing the resulting layout of hard disks before actually executing operations (so-called virtual 

operations). 

Copy Facilities 

 Migrate OS to SSD to move any Windows OS from a regular hard disk to a fast SSD (Solid State Drive) even of a 

smaller capacity, thanks to advanced data exclusion capabilities. 

 Migrate to/from Container to pack up a Windows system to a special container for later deployment on a 

different hardware configuration. 

 Partition/hard disk copy to successfully transfer all on-disk information including standard bootstrap code and 

other system service structures, thus maintaining the operating system’s working capability. 



9 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

 
Copy functionality can also be used as an alternative way of data protection. 

Virtualization Facilities 

 P2V Copy to migrate a Win2K+ physical system to a virtual environment in the online mode. 

 P2V Adjust to recover the startup ability after unsuccessful virtualization with a 3rd party tool. 

 
Virtualization is the latest trend in the system migration, protection, and evaluation. 

Partition/Hard Disk Management Facilities 

 Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the 

standard Windows disk tools, the program supports all popular file systems. 

 Mount a partition (assign a drive letter) of any file system type to make it available for your operating system. 

 Modify file system parameters (make active/inactive, hide/unhide, etc.). 

 Undelete Partitions Wizard to recover an accidentally deleted partition. 

Automatization Facilities 

 Task scheduling to automate routine operations. It can be particularly effective when you have to repeat a 

sequence of actions on a regular basis. 

 
Scheduling is only available for the Windows installation of the program. 

 Scripting to make the program create a script of any set of operations you need. Besides support of all 

operations available in the interactive mode, the unattended mode provides some additional features, such as 

conditional execution, subroutines, repeatable iterations, disk/partition properties analysis, errors 

management, etc. 

Auxiliary Facilities 

 GPT Loader is a special system driver to allow use of all space of modern ultra high capacity drives (larger than 

2.2TB) on systems that don't support it. 

 Conversion of basic MBR disks to basic GPT to enjoy all benefits of the newest partitioning scheme with 

minimal effort. 

 File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD 

as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to 

replace corrupted data from a previously created image in case of an operating system failure. 

 Volume Explorer is a handy tool when you have different file systems on the disk, whether they contain an 

operating system or just data. Volume Explorer will let you explore a file system of any type and provide access 

to the necessary files and directories regardless of their security attributes. 

 Recovery Media Builder to create a bootable recovery media based on Linux/DOS or WinPE 3.0 on a CD, DVD 

disc, or flash memory, which can later be used to boot and recover your computer in case of an operating 

system failure. Moreover, with its help you can save data from partitions of your hard disk directly to compact 
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discs or burn ISO-images. The utility supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, 

DVD-R, DVD+R double layer, Blu-ray and can handle multi-session burning. 

 Network Configuration Wizard to establish a network connection under Linux or WinPE either to save a backup 

of a partition/hard disk or just several files on a network computer or retrieve a previously made backup from a 

network computer for recovery purposes. 

 Boot Corrector to fix most of the system boot problems that can be a result of a human factor, program error or 

a boot virus activity. 

 

Boot Corrector is only available for the WinPE 3.0 or Linux/DOS bootable recovery 

environment. 

Supported Technologies 

Along with using innovative technologies from outside, Paragon has developed a number of its own original 

technologies that make its products unique and attractive for customers: 

 Paragon Hot Copy™ technology to copy locked partitions and hard disks under Windows NT+ family operating 

systems providing both high operating efficiency as well as low hardware requirements. 

 Paragon Adaptive Restore™ technology to successfully migrate a Win2K+ physical system to a different 

hardware platform (P2P). 

 Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, power 

outages or an operating system failure. 

 Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify 

and copy files and folders, etc. 

 Paragon Restore with Shrink™ technology to restore a backup image to a free block of smaller size taking into 

account only the amount of actual data of the image. 

 Paragon BTE™ technology to set tasks for execution in the Windows blue screen mode, thus saving from the 

need to use a bootable media when modifying system partitions. 

 Microsoft Volume Shadow Copy Service (VSS) to provide the copy/backup infrastructure for the Microsoft 

Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent 

point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the 

leading copy/backup solution vendors on the market, it is based on a snapshot technology concept. 

 GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift 

restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux. 

Retained GUID Partition Table (also known as Hybrid GPT), a special combined GPT+MBR partitioning scheme, 

where the first three partitions except for EFI (GPT service partition) are synced between GPT and MBR. This 

synced partition map provides an avenue, for instance for booting 32-bit Windows Vista/7 on a 2.2TB+ disk on 

computers controlled by the old BIOS. It’s also used for dual booting Mac OS X and Windows on a GPT disk. 

Supported Virtual Machines 

 Microsoft Virtual PC 

 VMware Workstation 

 VMware Fusion 

 Oracle VirtualBox 
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Supported File Systems 

 Full read/write access to FAT16/FAT32/exFAT partitions. 

 Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files are also 

supported. 

 Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions under all versions of Windows, DOS 5.0 and later. 

 Limited read/write access to Apple HFS+ partitions. 

 

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at 

the moment. The company is about to implement it in the nearest future. 

Supported Media 

 Support of both MBR and GPT hard disks (2.2TB+ disks included) 

 IDE, SCSI and SATA hard disks 

 SSD (Solid State Drive) 

 AFD (Advanced Format Drive) 

 Non-512B sector size drives 

 CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs 

 FireWire (i.e. IEEE1394), USB 1.0, USB 2.0, USB 3.0 hard disks 

 PC card storage devices (MBR and GPT flash memory, etc.) 

Getting Started 

In this chapter you will find all the information necessary to get the product ready to use. 

Distribution 

Paragon Drive Copy 11 is distributed in two ways: 

 Boxed package from Paragon Software GmbH and resellers 

 Downloadable package over the Internet at the company’s web-site 

Distributive CD 

The boxed package includes a distributive CD that is in fact a bootable recovery environment with auto-run of the 

Windows installation, thus it can be used as a ready-made solution. But if you’re going to run the Windows components, 

you need to install them first (see Installation). 

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation package 

as described in Online Distribution). 

Online Distribution 

Drive Copy 11 purchased over the Internet will be in form of an MSI package. After installing the product you can launch 

the Recovery Media Builder to prepare a recovery media. 
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Registration 

Paragon Software GmbH provides a wide range of online services through its web-portal - www.paragon-

software.com/support/: 

 Registration of new users; 

 Registration of purchased products for registered users; 

 Available around-the-clock downloading center, where registered users can get product updates/upgrades as 

well as all the necessary documentation; 

 Downloadable free demo versions and open documentation for all users. 

 
It is recommended to use Internet Explorer 5+ or any compatible browser. 

To register as a new user 

To register as a new user, please do the following: 

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/; 

2. Click Create of the Create a Paragon Account section; 

3. Fill out a registration form; 

4. Click Register. 

The most important field in the form is an E-mail address, as it serves as a login to enter the system. Besides your access 

password will be sent to this address as well. 

To register a new product 

If you are a registered user and would like to register Drive Copy 11, please do the following: 

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/; 

2. In the Email field of the Authorization section, enter an E-mail used for registration; 

3. In the Password field enter a password received after registration; 

4. Click Sign in; 

5. If the user name and password are valid, you will get to your account; 

6. Click Register new product of the Products section; 

7. Enter your product serial number in the Serial Number field. You can find it in the product box or obtain from 

your reseller. Click Next; 

8. On the next page you will be asked to provide some additional data. Also you will need to decide whether you 

want to get confirmation on registering the product by E-mail or not. Click Next, and then click Finish. 

That is all. The product is now registered. 

How to Download Updates/Upgrades 

Downloading of updates/upgrades can be fulfilled in the following way: 

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/; 

2. In the Email field of the Authorization section, enter an E-mail used for registration; 

3. In the Password field enter a password received after registration; 

http://www.paragon-software.com/support/
http://www.paragon-software.com/support/
https://www.paragon-software.com/my-account/login.htm
https://www.paragon-software.com/my-account/login.htm
https://www.paragon-software.com/my-account/login.htm
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4. Click Sign in; 

5. If the user name and password are valid, you will get to your account; 

6. Select My Downloads of the Products section to see what updates are available for you; 

7. Select the desired update and click Download. 

Contacting Paragon Software GmbH 

If you have any questions about the company products, please do not hesitate to contact Paragon Software GmbH. 

Service Contact 

Visit Paragon GmbH web site www.paragon-software.com 

Registration & updates web-service www.paragon-software.com/support 

Knowledge Base & Technical Support kb.paragon-software.com 

Pre-sale information sales@paragon-software.com 

System Requirements 

For the Windows installation package 

 Operating systems: Windows XP/Vista/7 and XP SP2/Vista/7 64-bit 

 Internet Explorer 5.0 or higher  

 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

 128 MB of RAM (256+ recommended) 

 Hard disk drive with 100 MB of available space  

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 

For the Linux bootable environment 

 Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed 

 256 MB of RAM  

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 

For the WinPE bootable environment 

 Intel Pentium III CPU or its equivalent, with  1000 MHz processor clock speed  

 At least 512 MB of RAM 

 SVGA video adapter and monitor  

 Keyboard 

 Mouse 

http://www.paragon-software.com/
https://www.paragon-software.com/support/index.html
http://kb.paragon-software.com/
sales@paragon-software.com
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Additional requirements 

 Network card to send/retrieve data to/from a network computer 

 External USB hard drive to store data. 

Installation 

To install Paragon Drive Copy 11, please do the following: 

1. Run Setup Application. Click on the *.MSI file. This application will guide you through the process of the 

program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user 

interface and set of installation steps. 

 

In case there is some previous version of the program installed on the computer, the 

program will offer the user to uninstall it first. 

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to 

continue. 

3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the 

agreement and then select the appropriate option to accept. If you do not agree with any conditions stated 

there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also 

be printed out. 

4. Provide Registration Information. On the Registration page you are to provide your product key and serial 

number. 

5. Provide Customer Information. On the Customer Information page you are to provide the standard 

information, i.e. a user name and an organization. Besides you need to decide whether to make the program 

available for all users of this computer (if several) or only for the current one. 

6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will 

be installed. By default, the installation folder will be created as: 

C:\Program Files\Paragon Software\Paragon Drive Copy 11. To select another folder, click the Change… 

button. 

After you have selected the required folder, click the Next button to continue. 

 

Do not install the program on network drives. Do not use Terminal Server sessions to install 

and run the program. In both cases, the program functionality will be limited. 

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or 

the Back button to return to any of the previous pages and modify the installation settings. 

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to 

abort the setup. 

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to 

complete the wizard. 

 

To accomplish online backup/copy of locked partitions/hard disks the program uses a 

kernel mode hotcore driver, thus the system reboot is required to complete the installation 

procedure. 
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First Start 

To start Paragon Drive Copy 11 under Windows, please click the Windows Start button and then select Programs > 

Paragon Drive Copy™ 11 > Paragon Drive Copy™. 

 

The program provides wide opportunities in the field of hard disk structure modification, so 

just to be on the safe side, please make a backup of your data before carrying out any 

operation. 

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization 

and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular 

basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page. 

 

 

To start up the traditional Launcher, please click on Switch to Full Scale Launcher. 

To know more on how to handle the product’s interface and accomplish typical operations, 

please consult the Windows Components chapter. 

Building Recovery Media 

Recovery Media Builder can help you accomplish the following operations: 

 Prepare the Linux/DOS recovery environment (included in the installation package) on external media (CD, DVD, 

or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get access to your hard disk 

for maintenance or recovery purposes (strongly recommended); 

 Prepare a custom Linux/DOS recovery environment by adding any data you like to the standard image; 
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 Prepare a bootable recovery environment from any ISO image, including our WinPE 3.0 image (strongly 

recommended); 

 Create from the master CD the Linux/DOS or WinPE recovery environment on a CD/DVD disc, or flash memory. 

Below you can find how to build our WinPE 3.0 based recovery environment on a thumb drive: 

1. Plug in a thumb drive of at least 250 MBs in size. Please note all data on that drive will be deleted. 

2. Launch the Recovery Media Builder. There are several ways to do it: 

 In the Main Menu: select Tools > Recovery Media Builder… 

 On the Common Tasks Bar: click the Recovery Media Builder item of the Wizards menu. 

3. On the Wizard's Welcome page, click the Next button. 

4. Select the Flash Memory option. 

 

5. Select the User specified CD/DVD image (.iso file) option, then browse for an ISO image of our WinPE 3.0 

recovery environment or manually type in a full path to it. By selecting the Typical option you can build our 

Linux/DOS recovery environment, which we highly recommend you to do as well. 

 

 

You can get an ISO image of our WinPE 3.0 recovery environment through the company’s 

web service. 

6. Select the required thumb drive from the list of flash memory devices available in the system at the moment (if 

several). 

 

7. You will have to confirm the operation. 
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Booting from the Linux/DOS Recovery Media 

The Linux/DOS recovery environment can be used to boot your computer into Linux or PTS DOS to get access to your 

hard disk for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-

standard situations such as interfering hardware settings or serious problems on the hardware level. In this case, only 

basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded. 

Startup 

To start working with the Linux/DOS recovery environment, please take the following steps: 

1. Start up the computer from our Linux/DOS recovery media. 

 

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery 

environment either on a CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

2. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu. 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right 

choice. 

4. Consult the help system by pressing ALT+F1 to know more on the subject. 

Boot menu 

The Boot menu contains the following commands: 

 

 Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended); 

 Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it 

fails to work properly; 

 Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be 

included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu; 

 Floppy Disk. Reboot the computer from a system floppy disk; 

 Hard Disk 0. Boot from the primary hard disk; 
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 Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any bootable operating 

system. 

To move within the menu, please use the arrow keys of the computer keyboard. 

 

While working with the recovery environment you might experience some inconvenience 

caused by possible video artifacts. It is just a result of changing video modes and in no way 

will affect the program functionality. If this is the case, please wait a bit and everything will 

be OK. 

Normal Mode 

When the Normal mode is selected, the Linux launch menu appears: 

 

 Drive Copy (enables to copy and back up separate partitions or entire hard disks, carry out partitioning 

operations, etc.); 

 Simple Restore Wizard (allows restoring hard disks and partitions); 

 Disk Copy Wizard (helps to clone a hard disk); 

 File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording them to 

CD/DVD); 

 Boot Corrector (helps to correct the Windows System Registry without Windows being loaded); 

 Network Configurator (enables to establish a network connection under Linux); 

 

If you are going to use network resources, first launch the Network Configuration Wizard to 

establish a network connection. 

 Log Saver (helps to collect and send the necessary log files to the Technical Support); 

 View the mounted partitions (the list of all mounted partitions will be displayed); 

 

The Linux/DOS recovery environment assigns drive letters to partitions the way it is done in 

DOS, i.e. one after another, primary partitions at first. Thus mounted partitions may have 

different drive letters from Windows. 
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 Eject CD/DVD; 

 Reboot the computer; 

 Power off the computer. 

To move within the menu, please use the arrow keys of the computer keyboard. 

Safe Mode 

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the 

Normal mode except the Network Configurator and Log Saver commands. Besides due to certain limitations of the PTS 

DOS environment, there is no possibility to burn CD/DVD discs. 

Low Graphics Safe Mode 

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks 

similar to the Safe mode but graphically simpler. 

 

Booting from the WinPE Recovery Media 

The WinPE recovery environment can be a real alternative to the Linux/DOS recovery environment. Providing nearly the 

same level of functionality it offers an excellent hardware support and the same interface as the Windows version does. 

Startup 

To start working with the WinPE recovery environment, please take the following steps: 

1. Start up the computer from our WinPE recovery media. 

 

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery 

environment either on a CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

2. Once it has been loaded, you will see the License Agreement. Read the agreement and then mark the 

appropriate checkbox to accept. If you do not agree with any conditions stated there, you won’t be able to use 

the program. 
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3. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables to run 

components of the product, load drivers for undefined hardware or establish a network connection. 

 

4. Click on the required operation to start. Hints on the selected at the moment item will help you make the right 

choice. 

5. Consult the help system by pressing ALT+F1 to know more on the subject. 

 

Our WinPE 3.0 based recovery environment offers excellent hardware support. However in 

case it doesn’t have a driver for your disk controller, your hard disks will be unavailable. 
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Please consult the Adding specific drivers scenario to know how to tackle this issue. 

Basic Concepts  

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general 

notion of the operation performance and makes it easier for the user to operate the program. 

Paragon Hot Processing & Volume Shadow Copy Service 

Offline versus Online Data Processing 

In the course of time there have been developed various methods of data processing. Despite different work concept, 

all of them can be divided into two principal groups: offline (cold) and online (hot) data processing techniques. 

As the name infers, offline data processing can only be accomplished when the data is in consistent state (the operating 

system and all the applications are completely shut down). Actually it is the most preferable way of image creation or 

data cloning, since software can obtain an exclusive right to process data that guaranties high level of operating 

efficiency. However, the offline data processing is absolutely out of question when dealing with 24/7 production 

environments. 

In contrast, online data processing enables to create a consistent snapshot even as the data is currently modified. It is 

particularly useful for systems with high availability requirements, but it won’t be accomplished until all active 

transactions are complete. The point is to provide a coherent state of all open files and databases involved in a process, 

taking into account that applications may still keep writing to disks. As a result an online data processing cannot boast 

high operating speed. 

Our program supports both offline and online methods of data processing. As far as online method is concerned it offers 

its own hot processing algorithm together with the possibility to use snapshot technologies provided by the Microsoft 

VSS framework. 

Paragon Hot Processing Technology 

Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systems. Developed 

back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company. 

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an online 

copy/backup, the program uses the kernel mode driver HOTCORE.SYS to intercept and control disk write activity of 

applications and the operating system. The hotcore driver as an integral part of the program is installed during the setup 

procedure (that’s why the system reboot is required to complete the setup procedure). For the most part the driver is in 

the idle mode until it is activated with the program. While in this mode it bypasses any calls having no effect on the 

overall system performance, but a few kilobytes of the system memory. 

Paragon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows NT+ family 

operating systems providing both high operating efficiency as well as low hardware requirements. 

Volume Shadow Copy Service 

Microsoft Volume Shadow Copy Service (VSS) is designed to provide the copy/backup infrastructure for the Microsoft 

Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-

time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading 

copy/backup solution vendors on the market, it is based on a snapshot technology concept.  



22 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and represents them as 

virtual read-only devices, called volume shadow copies. Once the shadow copies are created, the copy/backup utility 

starts processing the data while applications keep writing to original volumes. 

Unlike Paragon Hot Processing the VSS technology provides a unique possibility to make a synchronous snapshot of 

multiple volumes. This very feature can be particularly beneficial when backing up active SQL Server 2003, Exchange 

2003 or Oracle databases located on multiple volumes the way it is recommended by Microsoft to improve the level of 

database performance and reliability, thus providing 100-percent data consistency. 

 
To use VSS it is necessary to have a mounted 300 MB+ NTFS partition. 

GPT versus MBR 

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the 

old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC 

BIOS, it offers a number of crucial benefits: 

 Up to 128 primary partitions for the Windows implementation (only 4 in MBR); 

 The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR); 

 More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table; 

 A well defined and fully self-identifying partition format (data critical to the platform operation is located in 

partitions, but not in un-partitioned or hidden sectors as this is the case with MBR). 

To tackle compatibility problems with older operating systems there has been introduced a special combined GPT+MBR 

partitioning scheme called Retained GPT (also known as Hybrid GPT), where the first three partitions except for EFI (GPT 

service partition) are synced between GPT and MBR. This synced partition map provides an avenue, for instance for 

booting 32-bit Windows Vista/7 on computers controlled by the old BIOS. It’s also used for dual booting Mac OS X and 

Windows on a GPT disk. 

64-bit Support 

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user. 

However that is not the case when dealing with servers processing large amounts of data with complex calculations of 

very large numbers. That is where 64-bit architecture comes into play.  

It can boast improved scalability for business applications that enables to support more customer databases and more 

simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory 

allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor. 

With these resources, even a very large database can be cached in memory.  

Although many business applications run without problems on 32-bit systems, others have grown so complex that they 

use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources 

are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the 

database. 

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-

level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged 

support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing. 
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Copy Operations 

Hard drive duplication nowadays is becoming highly popular among PC users. That is due to some definite advantages it 

can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy 

utilities enable to successfully transfer all on-disk information including standard bootstrap code and other system 

service structures, thus maintaining the operating system’s working capability. In case of a system malfunction, the user 

can get the system back on track in minutes. No additional configuration is required, what is very convenient. 

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard drive doubles 

every two years, thus opening up new possibilities for software developers. As a result programs become more 

complicated and require considerable amount of free space. One day the user realizes that there is no more free space 

left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk, 

the user is to face a large re-installation procedure spanning several days of tedious work. But all of this can be avoided 

just by copying the contents of the old hard disk to a new one proportionally resizing the partitions. 

And the last but not least is the copying of hard disks for cloning purposes. It may be of great use when setting up 

similar computers. There is no need for a system administrator to install an operating system from scratch on every one 

of them. It is enough just to configure one and then clone it to the others. 

Drive Partitioning 

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up 

and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the 

entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity 

hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD 

images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective 

data organization and speed. 

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its 

work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard 

drives, but there is an easy solution – drive partitioning. Partitioning lets you divide a single physical drive into a number 

of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the 

operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is 

easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing 

video and another 50 GB for your favorite music collections to provide transparent data storage. 

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-

fragmentation or consistency check will not be that annoying and time-consuming any more. 

By detaching the OS from the rest of the data you can tackle one more crucial issue – in case of a system malfunction, 

you can get the system back on track in minutes by recovering it from a backup image located on the other partition of 

the hard drive. 

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the 

Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run 

several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the 

boundaries of each OS. 

Scheduling  

The automation of operations is particularly effective when you have to repeat a sequence of actions on a regular basis. 

For example, developing a specific project on a day-to-day basis and having to make a backup every evening so as not to 
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lose the valuable data, you will really appreciate, when this kind of routine operations will be carried out automatically 

without your participation. 

Another aspect of any automation process is that it allows an optimization of your computer’s work-load. This is 

especially important when operations require a considerable amount of computer resources – processor time, memory 

and more. A number of tasks, which can decrease the performance, can be run during the night or whenever the 

computer has the least work-load to perform. 

The program has a special tool for scheduling. You can set out a timetable for any operation and it will start at a 

specified time without interrupting your current activity. 

Windows Components 

In the given section you can find all the information necessary to successfully work with the Windows version of the 

product. 

Interface Overview 

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being 

made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are 

accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program 

can be tackled by reading this very chapter. 

General Layout 

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and 

dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration. 

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and 

functionality: 
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1. Main Menu  

2. Tool Bar  

3. Virtual Operations Bar  

4. Common Tasks Bar  

5. Explorer Bar  

6. Disk Map  

7. Partition List 

8. Properties Bar 

9. Legend Bar 

10. Status Bar 

A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them 

to simplify the interface management. 

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout. 

Main Menu 

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below: 

MENU ITEM FUNCTIONALITY 

Tools 
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View Log Files View logs on the carried out operations 

Recovery Media Builder… Restore the system even when the current operating system cannot boot 

anymore 

File Transfer Wizard… Transfer data from any media 

Settings... Edit the general settings of the program  

Exit Exit the program 

Changes 

Generate Script… Generate a script for the task 

Save to Scheduler… Schedule pending operations 

Undo `the last virtual 

operation` 

Cancel the last virtual operation on the List of Pending Operations 

Redo `the last virtual 

operation` 

Cancel the last undo virtual operation on the List of Pending Operations 

View Changes… Display the List of Pending Operations 

Apply Changes Launch the real execution of virtual operations 

Discard All Changes Cancel all virtual operations on the List of Pending Operations 

Reload Disk Info Refresh the current information about disks 

Wizards 

Create Partition… Create a partition of any file system 

Format Partition… Format a partition of any file system 

Delete Partition… Delete a partition of any file system 

Undelete Partitions… Recover an accidentally deleted partition 

P2V Copy… Migrate a live Win2K+ physical system to a virtual environment 

P2V Adjust OS… Make Windows Vista/7 backups bootable on virtual hardware; recover the 

startup ability after unsuccessful virtualization with a 3rd party tool 

Copy Hard Disk… Create a hard disk copy 

Schedule Hard Disk Copy… Set a timetable for a hard disk copy 

Copy Partition… Create a partition copy 

Schedule Partition Copy… Set a timetable for a partition copy 

Hard Disk 
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Convert to Basic… Convert a dynamic MBR disk containing simple volume(s) into a basic MBR disk 

Convert to Basic MBR hard 

disk… 

Convert a basic or a dynamic GPT disk containing simple volume(s) into a basic 

MBR disk 

Convert to GPT hard disk Convert a basic MBR disk into a basic GPT disk 

Update MBR Update MBR (Master Boot Record) of the selected hard disk 

Properties… Get in-depth information on the properties of selected hard disk 

Partition 

Create Partition… Create a partition 

Format Partition… Format a partition 

Delete Partition… Delete a partition 

Assign Drive Letter… Assign drive letter to the selected partition 

Remove Drive Letter… Remove drive letter for the selected partition 

Hide Partition… Make the selected partition unavailable for the operating system 

Unhide Partition… Make the selected partition available for the operating system 

Mark Partition as Active Make the selected partition bootable by default 

Mark Partition as Inactive Make the selected partition non-bootable by default 

Change Volume Label… Change volume label of the selected partition 

Check File System 

Integrity… 

Check the selected partition for possible file system errors 

Properties… Get in-depth information on the properties of selected partition 

View 

Layouts Manage the Launcher layout with several predefined profiles 

Toolbar Manage the Tool Bar representation: show / hide standard and navigation 

buttons, text labels and large icons 

Status Bar Display the Status Bar 

Common Tasks Bar Display the Common Tasks Bar 

Disk Map Legend Display the Disk Map legend 

Properties and Commands Display the Explorer Bar 

Disk Map Location Select whether the Disk Map will be located on the top of the main window or 

at the bottom 
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Help 

Help Open the Help system (you can also do it by pressing F1) 

About Open the dialog with information about the program 

 

 

The Main Menu contents available at the moment may vary depending on the selected 

object. 

Tool Bar 

The Toolbar provides fast access to the most frequently used operations: 

BUTTON FUNCTIONALITY 

 

Copy a hard disk 

 

Open the Help system 

Virtual Operations Bar 

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called 

virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations 

immediately, but places them on the List of Pending Operations for later execution. 

The Virtual Operations Bar enables to manage pending operations. 

BUTTON FUNCTIONALITY 

 
Cancel the last virtual operation on the List of Pending Operations 

 
Cancel the last undo virtual operation on the List of Pending 

Operations 

 
Display the List of Pending Operations 

 
Launch the real execution of virtual operations 

 
Cancel all virtual operations on the List of Pending Operations 

 

 

Virtual mode is an effective way of protection from any troubles, since no operations will 

be executed until clicking the Apply button for confirmation, thus giving a second chance to 

weigh all pros and cons of this or that particular operation. The program politely reminds 

the user that there are unsaved changes by showing the following window: 
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Common Tasks Bar 

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's 

wizards. 

The bar contains several tabs. Each tab includes a separate button bar which can be folded by clicking it. 

Basic Partitioning Tasks 

 
Starting the Create Partition Wizard to create a partition of any file system. 

 
Starting the Format Partition Wizard to format an existing partition to one of the 

file systems supported by the program. 

 
Starting the Delete Partition Wizard to delete a partition of any file system. 

Advanced Partitioning Tasks 

 
Starting the Undelete Partitions Wizard to recover accidentally deleted partitions. 

Copying Tasks 

 
Starting the Copy Hard Disk Wizard to copy a hard disk. 

 
Starting the Copy Partition Wizard to copy a partition. 

Tools 

 
Starting the File Transfer Wizard to transfer data from any media. Besides it 

provides access to Paragon backups as regular folders to browse through their 

contents or copy required files. 

Help and Documentation 

 
Launching the help system (you can also do it by pressing F1). 

 
Opening the page which contains information about the program. This page will 

be displayed in the Explorer Bar. 

 
Opening a brief review on the Paragon Scripting Language. 
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Disk Map 

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the 

bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map 

Location). 

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with 

rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the 

file system of the appropriate partition. 

 

Large-sized bars display the following information about physical disks: 

 Manufacturer, 

 Model. 

Small-sized bars display the following information about logical disks: 

 Serial number, 

 Drive letter, 

 Total size, 

 File system. 

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program 

offers to choose from several types of the disk layout scaling. It’s done especially to increase the program usability. For 

instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less 

than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the 

linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk 

layout is critical for you, the linear type is exactly what you need.  

Nevertheless there’s a compromise solution – linear scaling with the minimal limit to small partitions. So if a partition is 

too small it will remain readable. 

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type. 

 

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will 

automatically display detailed information on it. 

 

The drag-and-drop functionality is not available when the logarithmic type of the disk 

layout is selected. 
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Explorer Bar 

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays 

reference information including: 

 The help system; 

 General information on the product including its name, version and a list of helpful links; 

 Detailed information about disks selected on the Disk Map; 

 List of scripts; 

 List of scheduled operations; 

 Volume Explorer utility. 

According to these categories the Explorer Bar has several tabs: 

 Disk View, which offers the user the following options: 

- Partition List to get a clear-cut picture of the current state of the system hard disks/partitions; 

- Volume Explorer to browse and export contents of the selected partition/hard disk; 

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form. 

 

You can switch between these three components by clicking tabs on the left side of the 

Explorer Bar. 

 Scheduled Tasks, which gives the user the possibility of browsing and editing scheduled operations and the 

program scripts. 

 Help, which contains the program help and general information on the product. 

You can access the desired information by clicking on the appropriate tab. 

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the 

company's website to look through important technical notes or download the latest updates without having to close 

the program.  

The program help is also HTML-oriented. You can read it and follow external links from to get additional information. 

To easily navigate through browsed pages, the program provides the following functionality: 

BUTTON FUNCTIONALITY 

 
Return to the previously browsed 

page 

 
Open the next browsed page 

 
Stop loading the current page 

 
Refresh the contents of the current 

page 

Partition List 

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system 

hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the 
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possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed 

information on all hard disks/partitions found in the system including the following properties: 

   - Name, 

   - Volume label (if exists), 

   - Partition type (Primary/Extended /Logical), 

   - File system type, 

   - Size, 

   - Amount of used and unused (free) space, 

   - Start/End cylinder, 

   - Start/End head, 

   - Start/End sector 

   - Free size in sectors/bytes 

   - Active/Inactive attribute 

   - Hidden/Unhidden attribute 

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel. 

 

By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change 

its order by pressing the Move up or Move down buttons. 

If you don’t need the Disk Map, please click the shown below icon to disable it: 
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Properties Bar 

The Properties Bar provides information on the selected at the moment partition/hard disk: 

For a hard disk 

 Model, 

 Serial number, 

 Type of hard disk (basic or dynamic), 

 Total size (in GB), 

 Information on geometry of the disk (amount of sectors per track, heads and cylinders). 

For a partition 

 Drive letter assigned to the disk, 

 Volume label (if available), 

 Type of the logical disk, 

 File system (represented by the color of the graph and the selected bar), 

 Total size, used space and free space (in GB or MB). 

Besides you can modify practically any partition property by clicking on the required value. 

Legend Bar 

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with 

the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the 

Explorer Bar.  

The program distinguishes between the following types of known file systems: 

   - FAT16/32, 

   - NTFS, 

   - Linux Ext2/3/4, 

   - Linux ReiserFS, 

   - Apple HFS. 

Status Bar 

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to. 

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar. 
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Settings Overview 

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections, 

which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By 

selecting a section from the list, you can open a set of options. 


  

To get a detailed description to any setting, control, or field of the program just click the 

hint button and then the object you need. 

General Options  

 

This section contains a set of general options that will be taken into account during any operation carried out with the 

program: 

 Partition Alignment mode. There are three options you can choose from: 

- Legacy. DOS and Windows OSes before Vista required that partitions had to be aligned to the “disk cylinder” 

or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When 

partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters, 

thus resulting in a double read-write operation. 

- Vista. Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing 

scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole 

disk drive. It is optimal for both, 512B and new 4K disk drivers. 

- Inheritance. Select the option to disable automatic alignment of partitions. 

 Check FS integrity policy. Accomplishment of any data-sensitive operation (resize, move, merge, redistribute, 

change cluster size, etc.) is potential with data loss. To minimize this risk, it’s recommended to check integrity of 

your file system before this type of operations, despite the fact that it’s quite time consuming. We offer you 

several options to let you choose, which is best for you: 

- Always. Maximum protection, but minimal performance. The file system integrity will be checked each time 

it’s necessary to guarantee the maximum protection for the on-disk data. 

- Once. Standard protection with acceptable performance. The file system integrity will be checked for each 

volume only once just before accomplishing data-sensitive operations. 

- Never. No protection, but maximum performance. If you’re not 100% sure your disk is rock solid, please do 

not use this option. 
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 Data Loss Protection mode. To guarantee safety for your information when a data-sensitive operation has been 

abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that 

correspond to the options below: 

- Do not protect. No protection, but maximum performance. If you’re not 100% sure you’re completely safe 

from a power outage, or an accidental reset of your computer, please do not use this option.  

- Reset. Standard protection with acceptable performance. Maintaining a special journal, our program 

enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your 

computer from our bootable recovery media, thus reviving the corrupted partition. 

- Power loss. Maximum protection, but minimal performance. Besides journaling, our program will also 

disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a 

power outage. 

General Copy and Backup Options  

 

This section contains a set of options that will be taken into account during copy and backup operations: 

 HDD raw processing. Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, thus 

ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be 

processed as well). This can help to avoid problems with hidden data created by certain applications or the 

system administrator. However, it will take more time to accomplish the operation. 

 Partition raw processing. Mark the checkbox to copy a partition in the sector-by-sector mode to successfully 

process unknown file systems. However it is not recommended to enable this option when working with 

supported file systems as it takes more time to accomplish the operation. 

 Skip OS auxiliary files. Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus 

reducing the operation time and the resulted size of the backup image. 
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Hot Processing Options  

 

In this section you may configure the hot processing mode: 

 Enable hot processing. Mark the checkbox to enable the so called hot data processing mode that is specially 

designed to process data without restarting your operating system. 

 Hot processing technology. From the pull-down list you can select the required hot processing technology. 

 Always use hot processing. Select the option to process partitions without making them locked. Thus you will 

be able to keep working with them as usual. 

 Use hot processing only when partition is locked. Select the option to use the hot processing only when 

partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once 

you start any operation on a partition in this mode, it will automatically be locked by the program, thus you 

won't be able to keep working with it as usual. 

 Hot processing temporary drive. Here you can select a disk drive that will be used to store the temporary hot 

backup data (by default – C:). 

 Attempts to start VSS. Here you can set how many attempts to start Microsoft VSS the program is to do before 

automatically rebooting the system and accomplishing the operation in a special boot-up mode. 

 Timeout between attempts (in seconds). Here you can set a time period between different attempts to start 

Microsoft VSS. 

 Switch between hot processing technologies. Mark the checkbox to automatically switch between Paragon Hot 

Processing and Microsoft VSS if one of them is unavailable at the moment. 
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Partitioning Options 

 

This section contains a set of options that will be taken into account during partitioning operations: 

 Enable 64 KB cluster size for FAT16. Mark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you 

will be able to create FAT16 partitions up to 4GB in size 

 

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16 

partitions larger than 2GB are not reliably accessible under these operating systems. 

 Request confirmation before partition deletion. Mark the checkbox to activate an additional security 

mechanism. Thus when going to delete a partition you will be automatically requested to enter its label. 

 Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request 

confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion 

is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger 

hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get 

original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no 

way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition 

operation involving an extra upsizing. 

Virtual Mode Options 

 

In this section you may configure the virtual mode: 

 Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any 

troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all 

pros and cons of this or that particular operation. 

 
We strongly recommend you to enable this mode. 

 Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after 

accomplishing operations. 
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Log Files Options 

 

In this section you can specify a storage life span for the stubact.log file: 

 Infinite not to empty the file ever; 

 Minimal to have the file emptied all the time; 

 Custom to set a certain storage life span for the file. Please note, once the defined period has been expired, the 

file will be emptied. 

 

We strongly recommend you not to choose the Minimal option, as in case of having 

problems with the program, our Support Team won’t be able to study operation logs, thus 

help you out. 

Getting Information on Disks 

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state 

of the computer’s hard disks. 

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-

sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information 

about the disk in a bright, graphical form. 

 

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a 

circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may 

see a table, which contains the following information: 

 Type of hard disk (basic or dynamic), 

 Total size (in GB), 

 Information on geometry of the disk (amount of sectors per track, heads and cylinders). 
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When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as 

well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in 

accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right 

will contain the following information: 

 Volume label (if available), 

 Type of the logical disk, 

 File system (represented by the color of the graph and the selected bar), 

 Total size, used space and free space (in GB or MB). 

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the 

disk settings. 

Copy Tasks 

In this chapter you will find all the information necessary to make a copy of a hard disk or a separate partition. 

Cloning Hard Disks 

You can clone a hard disk of any file system. During the hard disk copying process, the program moves controlling 

records of used partitioning scheme, the bootstrap code and on-disk partitions. That’s why this operation cannot be 

substituted by simply copying all on-disk partitions. 

Copy Hard Disk Wizard 

The Copy Hard Disk Wizard is a traditional-like wizard. By going through its steps, you configure all the necessary 

settings to launch the copy operation. To minimize the possibility of making any mistake, the wizard provides auxiliary 

information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the 

wizard just by clicking the hint button and then the object you need. 

 
You need at least two hard disks to carry out this operation. 

Startup 

There are several ways to start the Copy Hard Disk Wizard: 
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Express Launcher 

 Click the Migration button and then select Migrate Hard Disk. 

Launcher 

 In the Main Menu: select Wizards > Copy Hard Disk… 

 On the Common Tasks Bar: click the Copy Hard Disk item of the Wizards menu. 

 In the Toolbar: click the Copy Hard Disk button. 

Setup 

The wizard offers the following steps to accomplish the copy hard disk operation: 

 The hard disk to copy. Select a hard disk you want to copy. 

 

 The target hard disk. Select a hard disk (if several) where all data of the source disk will be copied to. 

 

 Copy parameters. The wizard enables to specify the following options: 

 

Copy options 

- HDD raw copy to copy the hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g. 

unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid 

problems with hidden data created by certain applications or the system administrator. However, it will take 

more time to accomplish the operation. 

- Partition raw copy to copy the on-disk partitions in the sector-by-sector mode to successfully process 

unknown file systems. However it is not recommended to enable this option when working with supported file 

systems as it takes more time to accomplish the operation. 
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- Migrate to Retained GPT (also known as Hybrid GPT) to create on the target disk a special combined GPT+MBR 

partitioning scheme, where the first three partitions except for EFI (GPT service partition) are synced between 

GPT and MBR. This synced partition map provides an avenue, for instance for booting 32-bit Windows Vista/7 

on a 2.2TB+ disk on computers controlled by the old BIOS. It’s also used for dual booting Mac OS X and Windows 

on a GPT disk. Please note, this option is only available when the target HDD is larger than 2.2TB. 

 
Migrate to Retained GPT option is only available when the target HDD is larger than 2.2TB. 

 

Resize options 

- Remove free blocks between partitions not to keep blocks of free space between partitions on the targeted 

hard disk. 

- Copy data and resize partitions proportionally to make the program proportionally change the size of 

partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to a larger 

one. 

Result 

After the operation is completed, you receive a fully functional duplicate of the existing hard disk. 

 

To make a Win2K+ operating system bootable on different hardware, please additionally 

complete the P2P Adjust OS Wizard. 

 

Available operation scenarios: 

 Migrating system to a new HDD (up to 2.2TB in size) 

 Migrating system to a 2.2TB+ HDD 

Cloning Partitions 

You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning sample 

partitions. The program enables to duplicate all partition data including files, the exact structure of directories and file 

system metadata (location of files, security information, access quotas, etc.). 

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any 

mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description 

to any setting, control, or field of the wizard just by clicking the hint button and then the object you need. 

Startup 

There are several ways to start the Copy Partition Wizard: 

Launcher 

 In the Main Menu: select Wizards > Copy Partition… 

 On the Common Tasks Bar: click the Copy Partition item of the Wizards menu. 

Setup 

The wizard offers the following steps to accomplish the copy partition operation: 

 The partition to copy. Select a partition you want to copy. 
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 Destination disk. Select a hard disk with enough unallocated space to perform the operation. 

 

 

The program enables to copy a partition to a block of free space, which is smaller than the 

partition itself, taking into account only actual amount of data. 

 Copy parameters. The wizard enables to specify the following options: 

 

- Partition size. Define the size (in Mb) of the copied partition. 

- Free space before. Define the position (in Mb) of the copied partition relative to the beginning of the available 

range of disk space. 

- Free space after. Define the amount of trailing free space (in Mb) at the end of the available range of disk 

space. 

 

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. 

Result 

After the operation is completed you receive a fully functional duplicate of the existing partition. 

 

To make a Win2K+ operating system bootable on different hardware, please additionally 

complete the P2P Adjust OS Wizard. 
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Partition Management 

In this chapter you will find all the information necessary to carry out partitioning operations supported by the program. 

Basic Partitioning Operations 

Here you can learn how to accomplish basic partitioning operations (create, format, delete). 

Creating Partitions 

The program provides the ability to create a new partition by using the DOS partitioning scheme. This operation can be 

accomplished either with the Create Partition Wizard or the Create Partition Dialog. 

Restrictions 

1. Do not use the Create Partition function in order to undelete the last deleted partition. 

2. The program cannot create new partitions on Dynamic Disks. The current version of the program supports only 

hard disks that use the DOS partitioning scheme (in Windows 2000 and XP these disks are named Basic Disks). 

3. According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be 

created: 

- Two Extended Partitions on one hard disk 

- Five or more Primary partitions on one hard disk 

- If there is an Extended Partition on the disk, only three Primary partitions are allowed 

4. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free 

space on an existing partition to a new partition. 

Create Partition Wizard Startup 

There are several ways to start the Create Partition Wizard: 

Launcher 

 In the Main menu: select Wizards > Create Partition… 

 On the Common Tasks bar: click the Create Partition item of the Wizards menu. 

Dialog Startup 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a block of free space on the Disk Map; 

2. Call the Create Partition Dialog to set up the operation. There are several ways to do it: 

 Select in the Main Menu: Partition > Create Partition. 

 Call the popup menu for the block of free space (right click of the mouse button) then select the menu item: 

Create Partition. 

Create Partition Wizard Setup 

The wizard offers the following steps to accomplish the operation: 
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 Partition destination. Select a hard disk (if the computer has several hard disks) and then choose position for 

the future partition on the disk: at the end (preferable), at the beginning or somewhere in the middle between 

other partitions. 

 


  

By default, the program allows you to create a new partition only as the last primary or as 

the last logical drive within the extended partition. However, by activating the advance 

mode on the first page of the wizard you can remove this restriction that in its turn might 

result in some boot problems. 

 Partition size. There is no restriction on size of the future partition, merely depending on space available on the 

hard disk. 

If there is not enough free space in one block, the wizard enables to redistribute free space, joining all free 

space blocks together into one united block and moving partitions when necessary. If the total amount of free 

space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus 

resizing it. 

 


  

If a partition to resize is locked and cannot be processed, the wizard makes the system 

reboot to create the partition and then automatically boots the system again. (The 

rebooting mechanism is different for different versions of Windows.) 

You can also choose whether the future partition will be primary or logical by marking the appropriate 

checkbox. 
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 Partition properties. On the next page of the wizard you can set a number of additional parameters: 

 

- Partition type. From the pull-down list select a file system the newly created partition will be formatted to, 

otherwise the partition will remain unformatted (so that it will not be ready to use). 

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

- Surface test level. Define the level of the surface check to make the program find bad and unstable sectors and 

mark them unusable in the file system metadata. 

Dialog Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes 

button to confirm the operation. 

 

 Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type 

from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected 

block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free 

space, both Primary partitions or the Extended Partition can be created. 

 Partition Size. Define the size (in Mb) of the new partition. 

 Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free 

space. 
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 Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition. 


  

Partition size and position may also be defined by using the drag-and-drop technique. To do 

that, just carry out the required operation on the Disk Map. The virtual operations are to be 

available. 

 File system for new partition. From the pull-down list select a file system the newly created partition will be 

formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use). 

 Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

 Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly 

formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on 

the chosen file system, the following options become available: 

 

 Use OS built-in routine. Mark the option to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Define the level of the surface check to make the program find bad 

and unstable sectors and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set 

the number of sectors to be reserved for the boot area on the partition with this spinner control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 

amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 


  
Number of available options depends on the selected file system type. 

Result 

After the operation is completed you receive a fully functional partition. 

Formatting Partitions  

Any partition should contain some file system to be used for keeping data. The process of installing a file system is 

commonly known as formatting. A huge variety of file systems have been developed these days. 

Supported File Systems 

The program provides the ability to format partitions of the following file systems: 
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   - FAT12 & FAT16 

   - FAT32 

   - HFS+ 

   - NTFS 

   - Ext2 

   - Ext3 

   - Ext4 

   - Linux Swap v. 2 

This operation can be accomplished either with the Format Partition Wizard or the Format Partition Dialog. 

Wizard Startup 

There are several ways to start the Format Partition Wizard: 

Launcher 

 In the Main menu: select Wizards > Format Partition… 

 On the Common Tasks bar: click the Format Partition item of the Wizards menu. 

Dialog Startup 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map; 

2. Call the Format Partition Dialog to set up the operation. There are several ways to do it: 

 Select in the Main Menu: Partition > Format Partition. 

 Call the popup menu for the selected partition (right click of the mouse button) then select the menu item: 

Format Partition. 

Wizard Setup 

The wizard offers the following steps to accomplish the operation: 

 Partition to format. Select a hard disk (if the computer has several hard disks) and then the required partition to 

format. 
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As a result of this operation contents of the selected partition will be lost. 

 Partition properties. On the next page of the wizard you can set the following partition parameters: 

 

- Partition type. From the pull-down list select the desired file system type. In fact, the program displays only 

those file systems that can correctly be placed to the selected partition, taking its capacity into account. 

- Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

- Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly 

formatted partition. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the 

next page enables to define: 

 

 Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Define the level of the surface check to make the program find bad 

and unstable sectors and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set 

the number of sectors to be reserved for the boot area on the partition with this spinner control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 

amount of files/directories to be placed in the Root Directory on the FAT16 partition. 
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 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 


  
Number of available options depends on the selected file system type. 

Dialog Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format 

button to confirm the operation. 

 

 File system. From the pull-down list select the desired file system type. In fact, the program displays only those 

file systems that can correctly be placed to the selected partition, taking its capacity into account. 

 Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually 

used for drive identification. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on 

the chosen file system, the following options become available: 

 

 Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS. 

 Whether the surface test will be performed. Define the level of the surface check to make the program find bad 

and unstable sectors and mark them unusable in the file system metadata. 

 The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set 

the number of sectors to be reserved for the boot area on the partition with this spinner control. 

 The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum 

amount of files/directories to be placed in the Root Directory on the FAT16 partition. 

 The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control. 


  
Number of available options depends on the selected file system type. 
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Result 

After the operation is completed you receive a fully functional partition formatted to the specified file system. 

Deleting Partitions 

With the Delete Partition Wizard or the Delete Partition Dialog you can delete a partition on a hard disk partitioned with 

the DOS partitioning scheme. Unlike the majority of other utilities (Windows Disk Manager included), the program can 

not only remove references to the deleted partition from the Partition Table, thus making it unavailable for the 

operating system, but also enables to irreversibly destroy its data. This feature will guarantee security of your personal 

information. 

Wizard Startup 

There are several ways to start the Delete Partition Wizard: 

Launcher 

 In the Main menu: select Wizards > Delete Partition… 

 On the Common Tasks bar: click the Delete Partition item of the Wizards menu. 

Dialog Startup 

In order to start the operation you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map; 

2. Call the Delete Partition Dialog to set up the operation. There are several ways to do it: 

 Select in the Main Menu: Partition > Delete Partition. 

 Call the popup menu for the selected partition (right click of the mouse button) then select the menu item: 

Delete Partition. 

Wizard Setup 

The wizard offers the following steps to accomplish the operation: 

 Partition to delete. Select a hard disk (if the computer has several hard disks) and then the required partition to 

delete. 
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As a result of this operation contents of the selected partition will be lost. 

 Merge free blocks. As a result of the operation you may get several blocks of the unallocated space on the hard 

disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the 

required operation from the pull-down list. 

 

Dialog Setup 

Initially the program suggests you just to remove references to the selected partition from the Partition Table.  

 

 Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume 

Label. The current volume label is displayed above. 

 Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog. 

Result 

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the 

modification of the disk layout. 

Advanced Partitioning Operations 

Here you can learn how to accomplish advanced partitioning operations (merge, redistribute free space, undelete, etc.). 
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Undeleting Partitions 

When simply deleting a partition (without additional wiping) disk management software only removes references to it in 

the Partition Table, thus leaving the possibility to recover it later. 

The program enables to find and recover these partitions. A restored partition will be fully functional, as long as other 

partitions were not created, moved or exceeded the disk space occupied by that partition. That is why the program 

offers this function only for blocks of free space. 

The operation can be accomplished with the Undelete Partition Wizard. 

Startup 

There are several ways to start the Undelete Partition Wizard: 

Launcher 

 In the Main Menu: select Wizards > Undelete Partitions… 

 On the Common Tasks Bar: click the Undelete Partition item of the Wizards menu. 

 Select a block of free space on the Disk Map and click the Recover Lost Partitions item on the page that appears 

in the Explorer Bar. 

 Call the popup menu for the block of free space (right click of the mouse button) then select the menu item: 

Recover Lost Partitions… 

Setup 

The wizard offers the following steps to accomplish the undelete partition operation: 

 Free blocks to scan for lost partitions. Choose a free block from a tree-like list of available hard disks. 

 

 Search method. By default, the wizard selects the fastest search method for your operating system. In most 

cases that will do to find any accidentally deleted partition. However if you're under Windows XP for instance 

(the Conventional Search option is selected), but the deleted partition you're looking for has been created with 

the Disk Management utility under Vista, the wizard won't be able to find this partition, unless you manually 

select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizard 

still fails to find the partition you need, you can select the Thorough Search option to scan every single sector in 

the specified search area to get the most accurate results. 
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To know more on the available search methods, please use the context sensitive hint 

system. 

 File system filter. By default, the wizard will search for all known file systems. However, by clicking on the 

appropriate option on the second page of the wizard, you can specify only those file systems you need. 

 

 A partition to undelete (if several). By default, the program searches records of any deleted partition ever 

existed on the selected block of free space. So you can get several partitions to choose from. 

 

Most likely the required partition will be found first. If so, you may abort the search operation by pressing the 

Stop search button. 

Result 

After the operation is completed you receive a fully functional partition. 

Changing Partition Attributes 

This chapter explains how you can change partition attributes (Active flag, Hidden flag, Partition ID, Volume Label, etc.). 

Mark Partition Active/Inactive 

The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system 

will boot only if its partition is active or bootable. 

In order to mark a partition active/inactive you should take the following steps: 

Launcher 

1. Select a primary partition on the Disk Map. 

2. Call the Mark Partition Active/Inactive Dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Mark Partition as Active/Inactive. 
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- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select 

the menu item: Mark Partition as Active/Inactive. 

 

3. The operation will be performed immediately after confirmation. 

 

There can only be one active partition on a hard disk, otherwise your operating system will 

fail to boot. 

Hide/Unhide Partition 

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount 

hidden partitions, thus preventing access to their contents. 

In order to hide/unhide a partition you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map.  

2. Call the Hide/Unhide Partition Dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Hide/Unhide Partition. 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select 

the menu item: Hide/Unhide Partition. 

3. The operation will be performed immediately after confirmation. 

 

It is strongly recommended not to hide the system partition. Otherwise your operating 

system will fail to boot. 

Set Label of a Partition 

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is 

detectable by any partitioning tool and is used for notification purposes only. 

In order to change a partition label you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map. 

2. Call the Change Volume Label dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Modify > Change Volume Label. 

- On the Explorer Bar: click on the current volume label. 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select 

the menu item: Change Volume Label. 

3. Enter a label for the selected partition. 
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4. The operation will be performed immediately after confirmation. 

Hard Disk Management 

In this chapter you will find all the information necessary to carry hard disk operations supported by the program. 

Converting Dynamic MBR to Basic 

The program allows you to convert a dynamic MBR disk containing simple volumes into a basic one while keeping its 

contents intact. 

In order to convert a dynamic MBR disk into basic you should take the following steps: 

Launcher 

1. Select a dynamic MBR disk containing simple volumes on the Disk Map.  

2. Call the Convert to Basic dialog selecting in the Main Menu: Hard Disk > Convert to Basic… 

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard 

disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary 

partitions are allowed. That is why if a dynamic disk contains several simple volumes the program enables to 

choose the number of primary partitions. The rest of them if any will automatically be converted to logical disks 

within the Extended partition. 

 

 

The program can only process dynamic disks containing solid simple volumes (without 

extension). 

Converting GPT to Basic MBR 

The program allows you to convert a basic or a dynamic GPT disk containing simple volumes into a basic MBR disk while 

keeping its contents intact. 
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In order to convert a basic or a dynamic GPT disk into a basic MBR disk you should take the following steps: 

Launcher 

1. Select a basic or a dynamic GPT disk containing simple volumes on the Disk Map. 

2. Call the Convert to Basic MBR Hard Disk dialog selecting in the Main Menu: Hard Disk > Convert to Basic MBR 

Hard Disk… 

3. Set the required number of primary partitions if necessary. According to the DOS partitioning scheme a hard 

disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary 

partitions are allowed. That is why if a GPT disk contains several volumes the program enables to choose the 

number of primary partitions. The rest of them if any will automatically be converted to logical disks within the 

Extended partition. 

 

 

The program can only process dynamic GPT disks containing solid simple volumes (without 

extension). 

Converting Basic MBR to GPT 

The program allows you to easily convert a basic MBR disk into a basic GPT disk while keeping its contents intact. The 

operation is quite safe for the on-disk data, but you should know that only 64-bit Windows OSes since Vista are able to 

boot from this type of disks. So if you’ve got a 32-bit Windows OS accommodated on a disk you’d like to convert to GPT, 

it won’t start up after the operation is over.  

In order to convert a basic MBR disk to a basic GPT you should take the following steps: 

Express Launcher 

 Click the Adjustment button and then select Convert MBR Hard Disk to GPT. 

Launcher 

1. Select a basic MBR hard disk on the Disk Map. 

2. Call the Convert to GPT Hard Disk dialog to set up the operation by selecting in the Main Menu: Hard Disk > 

Convert to GPT hard disk. 
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3. The operation will be performed immediately after confirmation. 

 
The program can only convert basic MBR disks. 

Updating MBR 

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard 

bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a 

malfunction of boot management software. 

In order to update MBR of a hard disk you should take the following steps: 

Launcher 

4. Select a hard disk on the Disk Map. 

5. Call the Update MBR dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Hard Disk > Update MBR. 

- Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, then 

select the menu item: Update MBR. 

 

6. The operation will be performed immediately after confirmation. 

Task Scheduling 

Automation of operations can really help you out when you’ve got to accomplish certain routine operations on a regular 

basis as it enables to execute them without your involvement while optimizing your computer’s work-load. 

Setting a Timetable 

Thanks to the embedded Scheduler, you can set a timetable for execution of any operation. It has two categories for 

time settings (these correspond to appropriate items in the Schedule type menu): 

 Initiating the operation by an event: 

- One time only (i.e. the Once item) 

- When the system starts (i.e. the At System Startup item) 

- When the user logs on (i.e. the At Logon item). 

 Initiating the operation periodically (i.e. Daily, Weekly, Monthly). 
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You need to select one of the variants. Depending on your choice, the scheduler displays a form that enables to set a 

timetable. 

 

 

To run the task in the log-off mode, please specify administering login info by following the 

appropriate link in the left lower corner of the page. 

The Shutdown System on Complete option enables to automatically switch off the 

computer on the successful accomplishment of the operation. 

Managing Tasks 

All scheduled tasks are placed in a separate list, which can be retrieved by clicking the Scheduled Tasks tab in the 

Explorer Bar: 

 

On every task you can get in-depth information, including: 

 The task name 

 The full path to the generated script of the task 

 Scheduled time of launch 

 Statistics on the last launch 

 Scheduled time of the next launch 

 Used account information 
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 Comments to the task 

To easily manage tasks, the program enables to arrange them according to a certain characteristic just by clicking on the 

required property. 

 

This feature can be particularly beneficial when the Scheduled Tasks list contains too many 

items. 

You can also enable/disable, rename, delete, refresh or modify properties of the selected task. 

Task Editor  

With the Task Editor you can easily modify properties of scheduled tasks. To do that, you should take the following 

steps: 

Launcher 

1. Select a task on the Scheduled Tasks list. 

2. Call the Task Editor dialog. There are several ways to do it: 

- Click the Properties button on the Scheduled Tasks list. 

- Call the popup menu for the selected task (right click of the mouse button), then select the menu item: 

Properties. 

 

3. In the opened dialog window you can see two tabs - General and Schedule. Click the General tab to modify: 

 Full path to the macro-command program-interpreter, which describes the scheduled task; 

 Command line for starting the interpreter (i.e. the task described in macro-language) 

 Comments referring to the task 

 The option of enabling/disabling the task. 

By clicking the Schedule tab you can modify the task timetable. 
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In order to apply the changes, you need to click the Apply button at the foot of the dialog. 

Creating a Scheduled Task 

You can set a timetable for execution of any operation. For backup and copy operations the program offers handy 

wizards, while all the others can be scheduled with the Save to Scheduler dialog. 

To create a scheduled task you should take the following steps: 

Launcher 

1. Make sure the virtual mode of execution is enabled; 

2. Carry out with the program all operations you need to schedule; 

3. Call the Save to Scheduler dialog in the Main Menu: Tools > Save to Scheduler…; 

 

4. In the opened dialog enter the required task name and specify the task timetable; 

5. The operation will be performed immediately after confirmation. 

 
This command is unavailable if there are no operations on the List of Pending Operations. 

Scripting 

The program actions can also be represented in form of a script. The script describes the appropriate operation with 

macro-language commands. There is an interpreter utility - SCRIPTS.exe, which is included in the program installation 

package. This utility works in the unattended mode, which enables to automate operations. 

Startup 

You have no need to write a script since the program has a convenient interface for such a task. In order to generate a 

script on the base of the entered parameters of the required operation, you should take the following steps: 
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Launcher 

1. Make sure the virtual mode of execution is enabled; 

2. Carry out with the program all operations you need to be scripted; 

3. Call the Generate Script dialog in the Main Menu: Tools > Generate Script…. 

Setup 

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Generate 

button to confirm the operation. 

 

 Script file name and location. By default, the program offers to add the script to the Task List with a name 

containing its creation date and time. Unmark the Add to Task List checkbox to define an exact location and a 

filename for the script file. The default file extension that is reserved for scripting files is .psl, which however can 

be modified. 

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). 

To activate the advance mode, you need to click the More options button at the foot of the dialog page, so you will be 

able to define: 

 

 Interaction with the user. Mark the option to pause the script interpreter during the execution to prompt the 

user’s confirmation or other input. Otherwise the program will not stop using default values for parameters if 

needed. 

 Commit after each operation. Mark the option to commit changes after each operation. 

 Check for errors after each operation. Mark the option to insert a special code in script, which checks the status 

of the last executed operation and stops the script processing if there are errors of any kind. 

 Discard all operations on close. Mark the option to empty the List of Pending Operations after generating the 

script. 
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Result 

After the operation is completed you receive a new script file. It is placed into the specified destination, its features 

defined in the dialog. 

 

This command is unavailable if there are no operations on the List of Pending Operations. 

To learn more about scripts please consult the Paragon Scripting Language manual. 

Extra Functionality 

This chapter describes the supplementary functionality available in the program. 

View Partition/Hard Disk Properties 

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general 

information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry, 

cluster size, exact partition location, etc. 

There are several ways to get properties on a partition/hard disk: 

Launcher 

1. Choose a partition/hard disk on the Disk Map, then select in the Main Menu: Partition/Hard Disk > Properties…; 

2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map, then 

select the menu item: Properties… 

 

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get 

information you need. 



63 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

Volume Explorer 

Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted to 

FAT16, FAT32, NTFS, Ext2FS, Ext3FS, ReiserFS file systems. Besides it enables to access Paragon backups as regular 

folders to explorer their contents or to retrieve certain files. 

Launcher 

To launch the Volume Explorer you should click Disk View tab in the Explorer Bar and then choose Volume Explorer: 

 

Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location 

(local or network drive, etc.). 

 

File Transfer Wizard 

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of them to 

CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunction, caused either by 

a virus attack or files corruption, in order to get the system back on track again. Besides it provides access to Paragon 

backups as regular folders to browse through their contents or copy required files. 

Startup 

There are several ways to start the File Transfer Wizard: 

Express Launcher 
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 Click the Backup and Recovery button and then select Transfer Files. 

Launcher 

 Select in the Main Menu: Tools > File Transfer Wizard. 

 Select the Transfer Files item of the Wizards menu on the Common Tasks Bar. 

Setup 

The wizard offers the following steps to accomplish the transfer operation: 

 Place to look for files/directories. Select a source disk from the pull-down list in the left pane of the page. The 

program enables to process both mounted and unmounted (without drive letter assigned) partitions. Besides it 

is possible to map a network drive. 

 

 Object(s) of operation. Choose files/directories you want to copy and place them to Clipboard by pressing the 

Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane and press the Remove 

button. You can also create a new folder, rename or irreversibly delete existing files/directories of the left pane 

by pressing the appropriate buttons. 

 

 
Files/directories deleted from the Clipboard remain intact on source disks. 

 Destination to store the object(s). The File Transfer Wizard allows copying data to local or network drives, to 

physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the data will 

be stored. 
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 Revision of changes. The Transfer Summary page provides structurally divided information on all the actions 

made in the wizard. Check the changes and come back to any step of the wizard (if necessary) by following the 

required hyperlink. 

 

Result  

After the operation is completed the required data will be placed into the specified destination. 

Available operation scenarios: 

 Copying of data from the corrupted system disk to another hard disk 

 Burning of data from the corrupted system disk to CD/DVD 

Mount Partition 

The program enables to assign or remove drive letters of existing formatted partitions. 

Assign Drive Letter 

In order to mount a partition you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map.  

2. Call the Add Drive Letter dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Assign Drive Letter… 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select 

the menu item: Assign Drive Letter… 

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this 

parameter. So you may just press the Yes button to confirm the operation. 
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However you can manually define the required letter by selecting it from the pull-down list of available drive 

letters.  

4. The operation will be performed immediately after confirmation. 

Remove Drive Letter 

In order to un-mount a partition you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map.  

2. Call the Remove Drive Letter dialog to define appropriate settings. There are several ways to do it: 

- Select in the Main Menu: Partition > Remove Drive Letter. 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select 

the menu item: Remove Drive Letter. 

3. The operation will be performed immediately after confirmation. 

 

Modifying drive letter of the system partition will result in inability to boot the operating 

system. 

After having processed partitions with installed software, some programs may not run 

properly. 

Check File System Integrity 

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before 

performing any operation on a partition. 

To start the system integrity check you should take the following steps: 

Launcher 

1. Select a partition on the Disk Map 

2. Call the Check File System Integrity dialog to set up the operation. There are several ways to do it: 

- Select in the Main Menu: Partition > Check File System Integrity 

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then select 

the menu item: Check File System Integrity. 

 

3. The operation will be performed immediately after confirmation. 
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View Logs 

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all 

the information is structurally divided, besides there is the possibility to see the disk layout before and after an 

operation, what is very convenient.  

In order to view logs on carried out operations call the View Logs dialog in the Main Menu: Tools > View Log Files 

 

Typical Scenarios 

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can 

find here useful recommendations and descriptions of operations. 

System Migration Scenarios 

Migrating Windows OS to a solid state drive (Migrate OS to SSD) 

The latest SSDs do not boast high capacity, but rather smaller size and faster processing speeds over regular hard drives. 

Plus, they are completely indifferent to mechanical impact, a feature crucial for mobile computers. These benefits are 

leading more and more users to consider migrating at least OS to SSDs to get the most out of their systems. 

So, how do you migrate a Windows OS and hundreds of gigabytes of data on one huge volume to an SSD drive of 80-

128GB? Our Migrate OS to SSD Wizard can help you do that with minimal effort. 

To migrate any Windows OS since XP from a regular hard disk to a fast SSD, please do the following: 
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Express Launcher 

1. Connect an SSD drive to the computer. 

2. Turn on the computer. 

3. Click the Migration button and then select Migrate OS to SSD. 

4. The first page of the wizard informs the user on the upcoming operation. Please read all notes carefully before 

you proceed. To get additional information on the subject, click the Learn more about migrating OS link at the 

bottom of the window (highly recommended). Once you’re done with that, click Next to continue. 

 

 

All data stored on the destination disk will be lost during the operation. Please save it to 

another location beforehand. 

5. The wizard will scan your computer for system partitions that accommodate any of the supported Windows 

OSes. If several are found, it will let you specify which operating system you'd like to migrate. 

 

6. Depending on your choice, it will then automatically pick one or two on-disk partitions (Windows 7 may have 

Microsoft System Reserved, a special hidden partition that contains boot critical files) and prompt you to select 

a destination disk (if there are more than two drives besides the source). If the selected disk is enough in 
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capacity to hold your OS, it will prompt you to start the migration. If not (just our case), click on the link below 

the warning note to additionally exclude some data from the partition.  

 

7. Unmark checkboxes opposite unnecessary files or folders to try to fit into the destination disk. We do not 

recommend you to exclude system files, but those that could take plenty of disk space, like video, music, 

photos, etc. Once you’re ready with the exclusion, click OK to let the wizard calculate the resulted size of the 

partition. 

 

8. If a success, you’ll see a note that everything’s ready to start the migration. Since we’re going to use our SSD 

drive exclusively for Windows OS, we additionally mark the appropriate checkbox to let the wizard expand the 

resulted partition across all on-disk space. Click Copy to initiate the migration process.  
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That’s actually it. After the migration is over, you will need to configure the destination disk as the first boot device in 

BIOS to automatically start up the system from it. If a success, delete the Windows OS partition from the source disk, 

then re-partition the disk according to your needs. 

Migrating system to a new HDD (up to 2.2TB in size) 

Let’s assume that you’ve bought a new hard disk that is up to 2.2TB in capacity. It’s faster and of much higher capacity 

than your current system disk, so it’s quite natural you start thinking about system migration. We can help you do that. 

 

If the target hard disk exceeds the 2.2TB capacity limit, please consult the Migrating system 

to a 2.2TB+ HDD scenario. 

 

To migrate your system to a hard disk that doesn’t exceed the 2.2TB capacity limit, please do the following: 

Launcher 

1. Connect both source and destination disks to the computer. 

2. Turn on the computer. 

3. Click the Copy Disk item of the Wizards menu (any of the ways described earlier can also be used here). 

4. On the Wizard's Welcome page, click the Next button. 

5. On the Select Hard Disk to Copy page, select a source disk (a hard disk you want to copy). 

 

6. On the Select Target Hard Disk page, select a destination disk (a hard disk to copy contents of the source disk). 
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During the operation all contents of the destination disk will be deleted. 

7. On the next page of the wizard, define the copy options. In our case we’d rather copy data with a proportional 

resize to occupy the entire disk. Besides we recommend you to enable the surface test to make sure your new 

hard disk is flawless. 

 

8. On the Revise Copy Results page review all parameters of the operation. 

 

9. Complete the wizard and then apply the pending changes. 
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10. When copying is completed, shut down the computer. 

11. Disconnect (physically) the source hard disk. 

12. Boot the computer from the destination hard disk. 

 

To make a Win2K+ operating system bootable on different hardware, please additionally 

complete the P2P Adjust OS Wizard. 

Migrating system to a new HDD through container (notebook case) 

As you know the bulk of notebooks today are coming with one HDD connection port only, so there’s no way to attach 

two internal hard disks to a laptop simultaneously to accomplish system migration. Of course you can attach a new disk 

externally via a USB adapter, if you’ve got one. We offer you a better solution. 

To migrate your system to a hard disk that doesn’t exceed the 2.2TB capacity limit on a laptop, please do the following: 

Express Launcher 

Packing up system to a container on a network share 

As the first step we suggest packing up your system to a special container on a network share: 

1. Click the Migration button and then select Migrate Hard Disk to Container. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the What to Migrate page mark a checkbox opposite your hard disk’s name. 

 

4. Map a network disk to place the resulted container to: 

- Call the Map Network Drive dialog by clicking the appropriate button; 
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- Click the standard browse button [...] to browse for the required network share or manually enter a path to 

it; 

- Define a  letter from the pull-down list of available drive letters; 

- Mark the checkbox to make this connection permanent. Otherwise it will only be available for the current 

Windows session; 

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to 

access the selected network share if necessary. 

5. Give a name to the future container. 

 

 

Please take into account values of the parameters Estimated archive size and Space 

available on backup destination - if the archive size exceeds the available space, another 

network drive needs to be selected. 

6. Click Next to initiate the operation. In the Progress window you can see in real-time a detailed report on all 

actions carried out by the program. 
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7. When the operation is over, shut down your notebook to replace the original HDD with the new one. 

Deploying system from the container to the new hard disk 

To deploy your system from the container to the new hard disk, you need to use our WinPE bootable media: 

8. Start up the notebook from our WinPE recovery media. 

9. Click the Migration button and then select Migrate Hard Disk from Container. 

10. On the Wizard's Welcome page, click the Next button. 

11. Map a network disk where the container is stored: 

- Call the Map Network Drive dialog by clicking the appropriate button; 

 

- Click the standard browse button [...] to browse for the required network share or manually enter a path 

to it; 

- Define a letter from the pull-down list of available drive letters; 

- Click the Connect as user button at the foot of the dialog page to specify a user name and password to 

access the selected network share if necessary. 

 
You can also map a network disk with Network Configurator. 

12. Click on the container to select. 
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13. The What to Migrate page displays detailed information about the contents of the container. Select the entire 

hard disk. 

 

14. Select the new hard disk as destination. 
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All data stored on the destination disk will be lost during the operation. Please save it to 

another location beforehand. 

15. To help you get a clear-cut picture of the operation outcome, the program allows inspecting the resulted disk 

layout. If you’d like the program to proportionally change the size of partitions according to the capacity of the 

destination disk, select Copy data and resize partitions proportionally. You can also define whether the surface 

test will be accomplished during the operation or not. 

 

16. On the next page of the wizard confirm the operation by selecting the appropriate option. 

 

17. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

Mark a checkbox at the bottom of the window to automatically switch off the computer on the successful 

accomplishment of the operation. 

18. After completing the operation close the wizard. 

19. Boot the notebook from the destination hard disk. 
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To make a Win2K+ operating system bootable on different hardware, please additionally 

complete the P2P Adjust OS Wizard. 

Migrating system to a 2.2TB+ HDD 

Three terabyte hard drives have finally entered the market. With this whopping capacity on-board you can now store up 

to 400 hours of high-definition video, over half a million digital photos, even more MP3 songs, whatever. And they are 

affordable, approx. $0.08 per gigabyte, yet boasting an astounding 3-gigabit per second transfer speed, so your 

Windows can be agile as never before. Sure, you're already thinking of purchasing one of this type and migrating your 

software environment to it, aren't you? We can help you do that. 

But before you start, please make sure the following conditions are met: 

 You’ve got 32/64-bit Windows Vista or Windows 7; 

 At least 1GB of RAM; 

 The destination disk is greater than 2TB, empty and connected directly to the computer motherboard. 

To migrate your system to a hard disk that exceeds the 2.2TB capacity limit, please do the following: 

Express Launcher 

1. Click the Migration button and then select Migrate Hard Disk. 

2. On the Wizard's Welcome page, click the Next button. 

3. On the Select Hard Disk to Copy page, select a source disk (a hard disk you want to copy). 

 

4. On the Select Target Hard Disk page, select a destination disk (a hard disk to copy contents of the source disk). 

 

 
During the operation all contents of the destination disk will be deleted. 

5. On the next page of the wizard, define the copy options. Make sure you’ve selected the Migrate to Retained 

GPT option. Otherwise your system won’t start up after the migration is over. Additionally we’d rather copy 

data with a proportional resize to occupy the entire disk. Besides we recommend you to enable the surface test 

to make sure your new hard disk is flawless. 
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Migrate to Retained GPT option is only available when the target HDD is larger than 2.2TB. 

6. On the Revise Copy Results page review all parameters of the operation and modify size of the resulted partition 

if necessary. Please note that  

 

 

At this stage you don’t have access to the disk space beyond the 2.2TB limit. It’s done to 

bypass limitations of MBR. After migration is over and Paragon GPT Loader is installed, you 

will be able to partition this unallocated space. 

7. On the next page of the wizard confirm the operation by selecting the appropriate option. 

 

In the Progress window you can see in real-time a detailed report on all actions carried out by the program. Click 

More Options and mark a checkbox at the bottom of the window to automatically switch off the computer on 

the successful accomplishment of the operation. 
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8. When copying is completed, shut down the computer. 

9. Disconnect (physically) the source hard disk. 

10. Boot the computer from the destination hard disk. 

11. To get access to the disk space beyond 2.2TB limit, install Paragon GPT Loader by clicking the Adjustment button 

and then selecting Install GPT Loader. 

12. Restart the system when the installation is over. 

13. Now you’ve got access to the entire disk space and are able to perform functions such as creating a volume 

using our program or Windows Disk Management. 
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To make a Win2K+ operating system bootable on different hardware, please additionally 

complete the P2P Adjust OS Wizard. 

Making system bootable on different hardware (P2P Adjust OS) 

Let’s assume you had to migrate to a new hardware platform. You connected your system hard disk to the brand new 

PC and tried to start up the operating system - you do know for sure now that this operation had been doomed to 

failure from the very beginning. With our program you can easily tackle this naughty problem. 

Before you start, please make sure the following conditions are met: 

 You’ve got drivers for the new hardware ready to use, not zipped or in .exe files. 

 Your OS is unrolled on the new computer, not in a backup image. 

To make a Win2K+ physical system bootable on different hardware, please do the following: 

1. Start up the computer from our WinPE recovery media. 

 

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery 

environment either on a CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

2. Launch the P2P Adjust OS Wizard. 


  

Our WinPE 3.0 based environment offers excellent hardware support. However in case it 

doesn’t have a driver for your disk controller, your hard disks will be unavailable. Please 

consult the Adding specific drivers scenario to know how to tackle this issue. 

3. On the Wizard's Welcome page, click the Next button. 

4. From the list of all found Win2K+ systems (if several) select one you need to adjust to the new hardware. If 

you’re willing to adjust them all, just re-launch this wizard for each. 
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5. There are two execution modes to choose from: fully automatic and advance. Below we will go set-by-step 

through the automatic scenario to show the whole process, and then take a closer look at specifics of the 

advance scenario. 

 

6. Select Adjust the OS to the new hardware automatically. 

7. The wizard will automatically accomplish all the necessary actions. 

 

8. The only action that might be required from your side is to set a path to an additional driver repository in case 

the wizard has failed to find drivers for some boot critical devices in the built-in Windows repository. Generally 

together with new hardware you get its drivers for different operating systems on removable media (mostly CD 

or DVD). By collecting all these drivers in one folder you can let the wizard automatically pick and install only 

those required for your OS. Select Search for drivers in a specific folder. 

 

 

Click on the link at the bottom of the page to see what boot critical devices have no drivers. 

The wizard names all devices according to their model description, not some alphanumeric 

code, which is very convenient. 
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9. Though you’ve got the option to continue without injecting missing drivers for boot critical devices (The Ignore 

all missing drivers option), we strongly recommend you not to do it. Otherwise we cannot guarantee your 

Windows will start up on the new hardware. 

 

10. The wizard can search for drivers on a local disk or a mapped network share. In our case it’s on a network share, 

this is why we need to map it first. 
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11. When done, we can select it as target. 

 

 

 
The wizard enables to specify several driver repositories. 

12. If the wizard has found all missing drivers, it will ask you to confirm the operation. Apply the changes to 

complete. 
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After the operation is completed the system will be bootable on the new hardware. After the startup, Windows will 

initiate reconfiguration of all Plug'n'Play devices. It’s a standard procedure, so please don’t worry and prepare the latest 

drivers at this step to get the most out of the system. 

Advance scenario specifics 

1. To launch the advance mode, select Set parameters for the OS adjustment. 

 

2. When setting additional driver repositories, you can specify how to process drivers for found hardware. 

 

 Inject all necessary drivers… Mark the checkbox to force injection of all drivers for your devices from the 

given driver repository(s), even if there are already installed drivers for some hardware. Please use this 

option if you suspect any of the installed drivers of not matching your hardware. 

 Keep the latest driver version. Mark the checkbox to keep the latest version of drivers during the forced re-

injection. You can use this option only when the above option is active. 

3. Just before the OS adjustment, you can additionally: 

 View all found hardware devices and their driver status by clicking . The wizard names all devices 

according to their model description, not some alphanumeric code, which is very convenient. So you can 

compare the listed devices with the given hardware to make sure the wizard has analyzed your system 

correctly. 
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 Filter devices without drivers by clicking . Unlike the automatic mode, where only boot critical devices 

(storage controllers) without drivers are being reported, here you can view and inject drivers for network 

cards as well. 

 

 Add a driver for each device that lacks it by clicking on the device, then browsing for the required location. 

The wizard will then match the device with drivers inside the given location and pick the right one. 
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 Manually add a driver for a device that has not been found by our wizard by clicking , then specifying 

the required .INF file. 

 

 

 

When selecting an .INF file that contains several driver records for hardware you both, have 

in the system and don’t have, you can filter the list by marking the appropriate checkbox. 

 Remove a driver for a device, which has not been found in the system. 
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Virtualizing the current system (P2V Copy) 

Let’s assume that you’re about to migrate to a brand-new hardware platform with the latest operating system available 

for it. Your current system is quite obsolete, but you still need access to some of its software. You don’t want to waste 

time re-installing the old software to the new system, and you do know for sure that the bulk of it won’t work anyway. 

The best way out is to virtualize your old system. 

But before you start, please make sure the following conditions are met: 

 Your hard disk has enough free space to store a virtual image of your Windows (depends on the system). 

 You’ve got one of the supported virtualization software. 

To make a virtual disk out of your current system, please do the following: 

Launcher 

1. Click the P2V Copy item of the Wizards menu (any of the ways described earlier can also be used here). 

2. On the Wizard's Welcome page, click the Next button. 

3. Select objects you need to virtualize. You’re allowed to select any combination of hard disks and partitions, but 

don’t forget to choose your system partition (Local Disk C: in our case) to use it as guest. Otherwise the resulted 

virtual machine won’t start up. 

 

4. Specify the guest OS and a virtualization software vendor. If your system hosts several Windows OSes, our 

wizard will find them all and automatically patch to run in a virtual environment. However we cannot guarantee 

smooth startup of all found Windows systems for their configuration parameters may be incompatible with 
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each other. This is why we additionally prompt you to specify what operating system you’d like to use as guest 

to configure the virtual machine for that particular system. 

 

 

Not all vendors may be available to choose. If capacity of one of the selected objects 

exceeds the maximum virtual disk capacity of any vendor, this vendor will be shadowed. 

5. Set properties of the future virtual machine: 

 Virtual machine version. Please make sure you choose a version which is supported by your virtualization 

software, otherwise you won’t be able to work with the newly created machine. 

 Virtual machine name. By default the wizard picks the name of your guest OS, which can be modified 

however. 

 CPU number. If your computer supports multiprocessing, select how many CPUs you’d like to allocate for 

the virtual machine. 

 Memory amount. Depending on the guest OS the wizard calculates the recommended size of RAM, which 

can be modified however. 
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6. Set properties of the resulted virtual disk(s): 

 Virtual disk interface. By default the wizard sets the most appropriate interface for each disk. Anyway 

you’ve got the option to change it to one of the supported by your guest OS. Just click on a disk, and then 

select the required interface from the pull-down list. But be ready to provide drivers for it on the next page. 

 

 

 

Our program supports injection of drivers delivered in .iso or .flp images, so you can for 

instance download and inject drivers for the BusLogic controller from the VMware website. 

 Additional properties that depending on the selected virtualization vendor may include: 

- Size of the virtual disk. By default the wizard offers to create a virtual disk exactly the size of the selected 

object(s), which you can resize however (available for all); 

- Resize partitions proportionally. If you upsize the resulted virtual disk, you can make the wizard 

proportionally change the size of partitions keeping their relative order intact (available for all); 

- Create a split disk. You can choose whether to automatically cut the resulted virtual image to files of 2 

GBs or not (available for VMware only); 

- Pre-allocate all disk space. You can choose whether to pre-allocate all space of the future virtual disk, or 

do it dynamically (not available for VMware ESX and Oracle VirtualBox). 

 

 
The maximum limit you can downsize the virtual disk is the capacity of its first partition. 

7. Specify a file name for the virtual machine and its location. By default the wizard scans all your local disks for 

available free space and picks the most appropriate location taking into account the total capacity of all virtual 

disks inside the virtual machine. 
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8. Complete the wizard and then apply the pending changes. 

 

Making Windows Vista/7 backup bootable on virtual hardware (P2V Adjust OS) 

As you probably know, Windows Vista and later operating systems from Microsoft include a built-in disaster recovery 

tool, which enables to create backup images of Windows OS in a .vhd (Virtual Hard Disk) format, used now by Microsoft 

Virtual PC/Server/Hyper-V, and Oracle VirtualBox. Unfortunately you cannot just take this type of backup to run 

Windows OS in a virtual environment – it won’t start up. We can help you out with this naughty problem. Our P2V 

Adjust OS Wizard can patch Windows OS inside a .vhd backup image according to the specified virtualization vendor to 

let you start up and work with your Windows on virtual hardware. 

To make a Windows .vhd backup image start up in a virtual environment, please do the following: 

1. Click the P2V Adjust OS… item of the Wizards menu (any of the ways described earlier can also be used here). 

2. On the Wizard's Welcome page, click the Next button. 

3. Browse for the required .vhd backup image of your Windows. 
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4. Our wizard will detect a version of Windows OS inside the image and offer to specify a virtualization software 

vendor. At the present moment the .vhd format is supported by Microsoft Virtual PC/Server/Hyper-V, and 

Oracle VirtualBox. We choose the last one. 

 

5. Set properties of the future virtual machine: 

 Virtual machine version. Please make sure you choose a version which is supported by your virtualization 

software, otherwise you won’t be able to work with the newly created machine. 

 Virtual machine name. By default the wizard picks the name of your guest OS, which can be modified 

however. 

 CPU number. If your computer supports multiprocessing, select how many CPUs you’d like to allocate for 

the virtual machine. 

 Memory amount. Depending on the guest OS the wizard calculates the recommended size of RAM, which 

can be modified however. 
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If the selected version does not officially support the guest OS, you will be notified and 

prompted to select another one. 

6. Complete the wizard and then apply the pending changes. 

 

Recovery Scenarios 

Fixing MBR after a boot virus attack 

Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a boot virus attack, 

thus your system fails to boot. 

To fix the MBR of your hard disk, please do the following: 

1. Start up the computer from our Linux/DOS recovery media. 

 

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery 

environment either on a CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the 

option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware 

incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and 

keyboard drivers. This mode has simple graphics and a simple menu. 
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By default the Normal Mode will be automatically initiated after a 10 second idle period. 

3. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well. 

 

4. On the Wizard's Welcome page, select the Correct the Master Boot Record (MBR) option. 

 

5. On the next page choose the required hard disk from the pull-down list (if several) and then select the Update 

the MBR executable code option. 
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6. Confirm the operation. 

 

7. After the operation is completed click the Report button to see a well informative summary page. The program 

also enables to store the resulted report. To do that, just press the Save button and choose the exact location in 

the opened dialog. 

 

8. Click the Finish button to close Boot Corrector. 

9. Reboot the computer. 

Correcting BCD (Boot Configuration Data) 

To automatically correct BCD of a Win2K+ system, please do the following: 

1. Start up the computer from our WinPE recovery media. 

 

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery 

environment either on a CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

2. Launch Boot Corrector. 
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3. On the Wizard's Welcome page, click the Next button. 

4. Select Correct boot parameters… to let the wizard fix BCD in all found Win2K+ installations. 

 

5. The wizard will ask you to confirm the operation. Apply the changes to complete. 

 

After completing the operation close the wizard, and then reboot the computer. 

Fixing Windows startup ability 

Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything 

seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up. 

To fix your Windows startup ability, please do the following: 

1. Start up the computer from our Linux/DOS recovery media. 

 

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery 

environment either on a CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

2. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the 

option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware 

incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and 

keyboard drivers. This mode has simple graphics and a simple menu. 
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By default the Normal Mode will be automatically initiated after a 10 second idle period. 

3. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well. 

 

4. On the Wizard's Welcome page, select the Search for Windows installations to correct option. 

 

5. On the next page choose the required Windows installation from the list of found installations (if several), then 

select the Edit the Boot.ini file option. If you’re not sure which installation you need, please use the Properties 

button to get more info on the selected item. 
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6. Examine the file – maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate 

buttons. 

 

7. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to 

correct drive letters in the Windows System Registry. 
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8. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not 

sure which installation you need, please use the Properties button to get more info on the selected item. 

 

9. Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System 

Registry. 

 

10. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button. 

11. Confirm the operation. 

 

12. After the operation is completed click the Report button to see a well informative summary page. The program 

also enables to store the resulted report. To do that, just press the Save button and choose the exact location in 

the opened dialog. 
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13. Click the Finish button to close Boot Corrector. 

14. Reboot the computer. 

Copying of data from the corrupted system disk to another hard disk 

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot, 

please do the following: 

1. Connect the second hard disk to the computer. 

2. Start up the computer from our Linux/DOS recovery media. 

 

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery 

environment either on a CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 

3. In the boot menu select Normal Mode to use the Linux recovery environment (more preferable) or Safe Mode 

to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the 

option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware 

incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and 

keyboard drivers. This mode has simple graphics and a simple menu. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

4. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well. 
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5. On the Wizard's Welcome page, click the Next button. 

6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page. 

 

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 

 

Click the Calc button to estimate the resulted data size. 

8. On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive 

or a network share item. 
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9. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse 

button [...]. 

 

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the 

operation. 

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 

 

12. After the operation is completed, close the wizard by pressing the appropriate button. 

13. Turn off the computer. 

 
This operation can also be accomplished with the WinPE recovery environment. 

Burning of data from the corrupted system disk to CD/DVD 

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the 

following: 

1. Start up the computer from our Linux/DOS recovery media. 

 

Recovery Media Builder can help you prepare the Linux/DOS or WinPE recovery 

environment either on a CD/DVD disc or a thumb drive. 

To automatically boot from the recovery media please make sure the on-board BIOS is set 

up to boot from CD/USB first. 



102 

Copyright© 1994-2011 Paragon Software Group. All rights reserved. 

2. In the boot menu select Normal Mode to use the Linux recovery environment, since it’s the only mode that 

enables to burn CD/DVD discs. 

 

 
By default the Normal Mode will be automatically initiated after a 10 second idle period. 

3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well. 

 

4. On the Wizard's Welcome page, click the Next button. 

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page. 

 

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. 
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Click the Calc button to estimate the resulted data size. 

7. On the Select Destination Type, choose the way the data will be stored. Select the Burn data to CD/DVD item. 

 

8. On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label 

by entering it in the appropriate field. 

 

9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the 

operation. 

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program. 
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11. After the operation is completed, close the wizard by pressing the appropriate button. 

12. Turn off the computer. 

 
This operation can also be accomplished with the WinPE recovery environment. 

Extra Scenarios for WinPE 

Adding specific drivers 

Our WinPE 3.0 based recovery environment offers excellent hardware support. Anyway you’ve got the option to add 

drivers for specific hardware with a handy dialog. 

To add drivers for specific hardware, please do the following: 

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Load Drivers. 

2. In the opened dialog browse for an .INF file of the required driver package located on a floppy disk, local disk, 

CD/DVD or a network share. Then click the Open button to initiate the operation 
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To know how to map a network share, please consult the Configuring network scenario. 

3. You will be notified on the successful accomplishment of the operation. Click Yes to load another driver or No to 

close the dialog. 

 

 

Our WinPE 3.0 recovery environment is 32-based, thus you need to use 32-bit drivers for 

injection. 

Configuring network 

If your local network has a DHCP server, a network connection will be automatically configured once our WinPE 

recovery environment has been started up. Otherwise you will need to do it manually with a handy dialog by providing 

an IP address, a network mask, default gateway, etc. Besides with its help you can easily map network shares.   

To manually set up a network connection and map a network share, please do the following: 

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Configure Network. 

2. In the opened dialog provide an IP address, a network mask, default gateway, etc. for your network device. 

 

3. Click the Network drivers tab to map a network share. 

 

4. Click Map Network Drive and provide all the necessary information to map a network share in the opened 

dialog:  
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 Click the standard browse button [...] to browse for the required network share or manually enter a path to 

it; 

 Define a letter from the pull-down list of available drive letters; 

 Click the Connect as user button at the foot of the dialog page to specify a user name and password to 

access the selected network share if necessary. 

By clicking Disconnect Drive… you can delete an existing network share if necessary. 

5. Click the Network identification tab to change a network name of your computer (generated automatically) and 

a workgroup name. 

 

6. By default, the wizard saves all network settings in the netconf.ini file located on the WinPE RAM drive, thus it 

will only be available until you restart the computer. However, you can just once configure your network device 

and then save this file to some other destination, for instance a local drive, and this way avoid constant re-

configuration, just by providing a path to it. So Click Save to file to save the netconfig.ini file to the required 

destination. 

Saving log files 

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of 

having difficulties with handling the program, you, with the help of this very function, can address the company support 

engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in 

order to tackle the encountered problem. Information of that kind is stored in log files. 

To prepare a log files package, please do the following: 

1. Once you accept the agreement, you will see the Universal Application Launcher. Click Log Saver. 

2. In the opened dialog browse for the required location of the log files package or manually provide a full path to 

it. Click Collect to initiate the operation. 

 

 

Log files do not contain any confidential information on the operating system settings or 

the user documents. 
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Troubleshooter 

Here you can find answers to the most frequently asked questions that might arise while using the program. 

1. I try to run an operation, but the program claims my partition is in use and suggests restarting the computer. 

There are a number of operations that cannot be performed while your partition is in use (or locked in other 

words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-

up mode. 

2. I run an operation and restart the machine as required, but it just boots back into Windows without 

accomplishing the operation. 

Please run 'chkdsk /f' for the partition in question. 

3. I cannot create a new partition on the disk. 

There can be a number of reasons for that: 

 The program cannot create a new partition on a dynamic disk, but only on a hard disk that uses the DOS 

partitioning scheme. 

 According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot 

be created: 

- Two Extended Partitions on one hard disk; 

- Five or more Primary partitions on one hard disk; 

- If there is an Extended Partition on the disk, only three Primary partitions are allowed. 

 The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert 

a free space on an existing partition to a new partition. 

4. I cannot copy a partition. 

There can be a number of reasons for that: 

- The source or target disk you select is a dynamic disk; 

- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk. 

5. I need to copy a partition. But when selecting a place where to make a copy, I always get a crossed circle sign no 

matter which partition is selected. 

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free 

space on your hard disk, please delete or reduce an existing partition to accomplish the operation. 

6. I cannot do anything with my USB flash drive. I get a crossed circle sign when trying to select any area on it. 

Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix the 

issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a 

standard code to your flash drive. 

7. When trying to back up my system the program asks to restart the computer. 

Most likely the Hot Processing mode is disabled. Please make it active in the program settings. 

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could 

not be started for processed volume". 

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot 

Processing mode instead. 
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9. I cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the 

following error: Hard Disk management, Error Code 0x1100a. What is wrong here? 

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this 

service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My 

Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to 

start it automatically). 

10. When running a backup operation with the Paragon Hot Processing mode enabled, I get an error: error code 

0x1200e "Internal error during Hot Backup" 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

11. When running a backup operation with the Microsoft VSS mode enabled, I get the following error: error code 

0x12016 "VSS: can't read volume data” 

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool. 

You can find a name of the tool you need here: http://kb.paragon-software.com 

12. When trying to back up to a network share, I get the following error: "i/o error" or "can't open/create file" 

Please check whether you’ve got a permission to write to the selected destination or not. 

13. When trying to restore a backup archive, I get the following error: "Can't restore to current selection" or 

"Archive does not fit" 

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa. 

14. I set up a timetable for a task, but it fails to execute. 

There can be a number of reasons for that: 

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call 

Notepad through scheduling); 

- You don’t have permission to write to the selected backup destination. 

Glossary  

Active Partition is a partition from which an x86-based computer starts up. The active partition must be a primary 

partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.  

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap. 

The term backup originates from the time when the best way to protect valuable information was to store it in form of 

archives on external media. It’s become now a general notion to mean making duplications of data for protection 

purposes. 

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will 

be able to restore the data from these archives without having to run the program, but by simply booting from these 

CD/DVDs. 

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows 

organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the 

more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based 

on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of 

fragmentation on the volume. A cluster is also called an allocation unit. 
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Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is 

used if you want to create more than four volumes on a disk, since it may contain multiple logical drives. 

File System Metadata. The servicing structures of a file system, which contain information about allocating files and 

directories, security information etc, are named the file system metadata. It is invisible for users and regular 

applications because its accidental modification usually makes a partition unusable. 

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are 

divided into tracks (or heads), and tracks are divided into sectors. 

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard Disk 

Geometry or C/H/S geometry. 

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an 

essential role in the DOS Partitioning scheme. 

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors 

are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can 

additionally emulate the C/H/S geometry. 

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an 

operating system does not mount a hidden partition, thus preventing access to its contents. 

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by 

XOR-ing the partition ID with a 0x10 hexadecimal value. 

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file attributes. It 

contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a 

FAT file system. 

MBR & 1st track of the hard disk is the 0th sector of the disk. MBR (Master Boot Record) contains important 

information about the disk layout: 

- The used partitioning scheme; 

- The starting records of the Partition Table; 

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses). 

Generally, the 0th sector is used for similar purposes in all existing partitioning schemes.  

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed 

to use the entire 0th track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot 

Manager are located in the 0th track. 

Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect 

partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions. 

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space. 

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's boot 

sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK 

utility. 

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively 

large amount of text in multiple languages. 

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on partitions 

located on a hard disk. 
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There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It 

was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible 

computers. 

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX 

mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating 

system. 

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new 

Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition, 

most hard disk utilities do not support it as well. 

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or 

recovery purposes. 

Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In modern file 

systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12 

and FAT16 file systems. 

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number 

represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is 

initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility. 

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows 

NT, 2000 and XP store its value in the database of assigned drive letters. 

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when 

the partition is formatted. It does not play an important role for most operating systems and software as well. 


